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1. Introduction 

Conventions Used in this Document 
Italic font is used for: 

 program and component names 

Boldface is used for: 

 chapter and section headlines 

 important notes 

 cross references 

Courier New font is used for: 

 any text typed by the user 

 file content and names 

 

Note: 

 

 Displays important information which should not be ignored. 

 

Please note: 

 Logos incorporating the Admiralty  are trademarks of the UKHO. 

 Screen layouts illustrated in this user guide may differ from the actual one. 

 The information described in this user guide is subject to change without notice. 

 Not all the functions described in this user guide may be supported by all Equipment Manufacturers’ 
systems. 

 Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries. 
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2. Service Overview 
 

The Admiralty Digital Catalogue combines the Paper Charts, ARCS, AVCS, ECDIS Service, Admiralty Publications and 

Digital Publications catalogues. The catalogue also has the facility to display current Temporary and Preliminary Notices 

to Mariners.  

 

Navigators can view the limits of all the products and overlay a ship’s route to compute the chart coverage needed for a 

safe passage. A typical scenario may be to select all available ENCs within the AVCS with gaps being filled in by ARCS 

or paper charts. An inventory function can be used to filter charts and ENCs that are already on board. The resulting list 

of required charts and ENCs left in the basket can be saved and emailed to a distributor of your choice as an enquiry for 

an order. Other products such as List of Lights or TotalTide can be selected simultaneously. The contents of the AVCS 

and ECDIS Service folios can also be viewed either graphically or textually. 

 

The catalogues can be easily updated online with the latest data to ensure the charts and products available are always 

current. 
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3. Getting Started 

System Requirements 
To ensure trouble-free functioning the following minimum requirements must be met: 

 Windows XP (Service Pack 3 recommended), Windows 7 (32/64 bit), Windows 8 

 Screen resolution 1024 by 768 pixels 

 Processor 2 GHz 

 512 MB of RAM 

 100 MB free disk space for the installation 

 Fast Internet access for future catalogue downloads 

Installation of Admiralty Digital Catalogue 
Admiralty Digital Catalogue can either be downloaded from the UKHO website. 

 

 Extract zip files named ADC_Full.zip 

 Start Setup.exe 

 Follow the instructions displayed on the screen. 

  

This will install Admiralty Digital Catalogue on your computer. 

 

Note: Any previously installed version of Admiralty Digital Catalogue must be closed prior to the 
installation of the new version. 

Connection to Server for Online Updates 
Admiralty Digital Catalogue reads the proxy information if available and then builds up the connection for downloading 

the catalogues to be updated. 

 

The proxy settings to connect to the server are defined in Settings → Control Panel → Internet Options → tab 

Connections → LAN Settings → section Proxy Server. 
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4. Service Details 
 

What is Admiralty Digital Catalogue? 
Admiralty Digital Catalogue is a service program of The United Kingdom Hydrographic Office (UKHO) allowing you to 

manually select and combine vector charts, raster charts (ARCS) and paper charts (SNCs) into a single package. 

Additionally, other Admiralty products such as TotalTide and Digital List of Lights can be included. 

 

Based on this selection distributors can create quotes, and customer orders can be placed. The products to be ordered 

are saved in a Shopping Basket and this file can then be transmitted by the customer to a distributor, selectable from a 

list. 

 

Admiralty Digital Catalogue allows the customer to view, supplement, replace, renew, and optimise an inventory of 

charts at any time. This is supported by various search options, e.g. manual route selection, search for specific port 

names, creation of lists, etc. 

Updating Catalogues 
The chart catalogue files are regularly updated to ensure they are always current. 

 

If the chart catalogues have not been updated or checked for updates for more than 7 days an out-of-date warning 

message will be displayed when Admiralty Digital Catalogue is started (see Figure 1 unterhalb). The catalogue can be 

updated online by selecting ..from the WWW-Site? or ..from a folder on the disk?. However, you can ignore this 

message by choosing …later? (Use the catalogue menu) or clicking the Cancel button. 

 

 

 

 

 

 

 

 

 

 

 

Figure 1 - Window Catalogue Warning 

After clicking on OK the Available Catalogue Updates window will open, and display information about the catalogues 

which need to be renewed (see Catalogue unterhalb). 

 

 

 

 

 

 

 

 

 



JRC User Guide V1.0 
JRC User Guide V1.0 

7 

 

The User Interface 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2 - ADMIRALTY Digital Catalogue User Interface 

 

The Admiralty Digital Catalogue User Interface is divided into the following components: 

1. The Menu Bar 

2. The Navigation Bar 

3. The Navigational Globe 

4. Overlay Settings 

5. Filter 

6. The Chart Display 

7. The Tab Bar 

8. The Context Menus (via right mouse button) 

 

The Menu Bar 
The Menu Bar includes the following items: 

 

 

 

Figure 3 - The Menu Bar 

 

 

 

 

 

 



JRC User Guide V1.0 
JRC User Guide V1.0 

8 

 

Menu Item File 

The menu item File includes the following functions: 

 

 

 

 

 

 

 

 

 

 

Figure 4 - Menu item File 

Catalogue 

The function Catalogue includes the following entries:  

 Online Update of Catalogue… 

 Load Catalogue from Disk… 

 Status Of Catalogue… 

 

Online Update of Catalogue 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5 - Available Catalogue Updates dialogue 

In the Available Catalogue Updates window information about the chart data is displayed. 

 In the left column the Catalogues are listed. 

 Status On This PC displays whether the data is Up To Date or not. 

 Date On This PC displays current date of data. 

 Available Date displays the date of the available updates. 

 Load Update? allows selecting of the catalogues to be updated. 

 File Size gives the size of the catalogue files. 

 Download Progress is symbolized while updating. 

 Clicking on Start Update will load the selected data and update Admiralty Digital Catalogue. Clicking on 
Cancel Update will cancel the update process. 
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Load Catalogue from Disk 

This entry opens a window in which the file ACCatalogs.zip can be selected. It is used if catalogue updates are 

supplied on disk or by email. 

 

Status of Catalogue 

This entry displays the date of each catalogue loaded onto the PC.  

 

 

 

 

 

 

 

 

 

 

 

Figure 6 - Catalogue Status 

Load Basket… 

This function opens a file selection box which allows the user to load a previously saved basket file (.txt) or and e-

Navigator basket file (.bsk) into the Shopping Basket.  The saved basket file contents are added to any products already 

within the basket. 

 

The format is as follows: 

Product Type Product Number  

ENC Units IT400106  

ARCS  122  

 

Save Basket… 

This function allows the user to save the content of the Shopping Basket into a file. It is also possible to save the basket 

file in a comma separated value (.csv) format so that the contents of the basket can be easily imported into Microsoft 

Excel. 

 

Load Inventory… 

This function opens a file selection box which allows the user to load a previously saved inventory file into the Inventory. 

The file extension is .txt. 

 

An inventory text file from another source can also be loaded into the catalogue. It must comply with the correct 

catalogue format as follows: 

 

Product Type Product Number  

ENC Units IT400106  

ARCS  122  
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If the current inventory already contains a number of products, the user is asked whether to overwrite or merge the 

contents. 

 

 

 

 

Figure 7 - Message window to overwrite or merge contents of Inventory 

Load Permit File… 

This function opens a file selection box which allows the user to use a raster or vector chart permit file to populate the 

inventory.  The populated charts are highlighted in the catalogue. Please note invalid cells are not loaded. 

Save Inventory… 

This function allows the user to save the content of the Inventory into a file.  

Import Chart list… 

This function allows the user to load a list of products, for example paper charts, and have these products highlighted in 

the chart display, added to the shopping basket or added to the inventory. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8 – Import Chart List 

 

Open File – the file that contains the list of products. 

Select Product Type – the type of product in the file, ARCS, BA Charts, ENCs. 

Select Field Number for Product ID – where the file contains more information than just the product code, this defines 

where the product code can be located. 

No. of Header lines – where the file contains headings this identifies the number of header lines; this is to say the 

number of lines at the start of the file that will be ignored. 

Comment Lines – where the file contains comments enables the wizard to identify these and ignore them. 

Field Separator – where the file contains more information than just the product code, this identifies how the information 

is separated, for example by comma or tab character. 

Copy To Basket – will add each product in the file into the catalogue basket. 

Copy To Inventory – will add each product in the file into the catalogue inventory. 

Just Highlight – highlights all the products in the file, useful to select products on the current tab based on the limits of a 

different type of product, for example loading and highlighting a list of BA Charts which can be used to select ENCs. 

Next – will preview the file using the current settings. 
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Figure 9 – Import Chart List 

 

This form enables the user to preview the file, to check that the correct field has been identified as the product ID. 

Back – will take the user to the previous screen so that the import parameters can be modified. 

Finish – will process the file. 

Cancel – will cancel the import. 

Exit 

This function terminates Admiralty Digital Catalogue. 

Menu Item View 

The menu item View includes the following functions: 

 

 

 

 

 

Figure 10 - Menu item View 

Basket Dialogue 

In the Shopping Basket all products that have previously been selected are displayed. A list of products to be ordered 

can be compiled. 

The Shopping Basket can also be opened by clicking on  in the Navigation Bar. 

 

 

 

 

 

 

 

 

 

Figure 11 - Shopping Basket without Inventory 
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There are several buttons in the lower part of the Shopping Basket window for handling the contents. The functions are: 

 
Zoom to selected product(s). 

 
If on, selected product(s) will be highlighted in the Chart Display.  

 
Remove selected product(s) from basket. 

 
Remove all products from basket. 

 
Mark products in basket that are already in the Inventory. 

 
Load basket file. 

 
Save basket file to a text or CSV file. 

 
Edit Ship Information. Opens the Ship Information/Registration Dialogue. 

 
Show List of Distributors in Browser. Opens the list of UKHO distributors 

 
Import Chart Wizard, imports a list of products into the basket. 

 
Check if Unit-Cells are included in Folios 

 
Undo last Basket or Inventory modification (the redo is a mirror icon). 

When AVCS Folios and ENCs are included in the Shopping Basket there is the possibility that duplicate ENCs may 

exist. By clicking on Check if Unit-Cells are included in Folios this will check and report any duplication and provide the 

option to remove any duplicate cells. 

 

 

 

 

 

Figure 12 – Check for duplicate cells 

 

By clicking on  the Shopping Basket window is supplemented with an Inventory window. All products 

which have been selected for or loaded into the Inventory are displayed within it. 

 

Clicking on  closes the Inventory window. 

 

 

When the Inventory is open products can be exchanged between the Shopping Basket and Inventory. This is done by 

means of the two buttons 

 
Move selected product(s) from Basket to Inventory. 

 
Copy selected product(s) from Inventory to Basket. 
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Figure 13 - Shopping Basket with open Inventory 

In the Inventory there are also several buttons with the following functionality: 

 
Zoom to selected product(s). 

 
If on, selected product(s) will be highlighted in the Chart Display.  

 
Remove selected product(s) from Inventory. 

 
Remove all products from Inventory. 

 
Load a saved inventory file or a list of products from a text file into the Inventory. 

 
Load a permit file into the Inventory. 

 
Save a list of products in Inventory to a text file. 

 

Contents of Basket and Inventory 

Both the Shopping Basket and Inventory include the following columns: 

 

Product Type Name of the catalogue the product belongs to. 

Product Displays the identifier of the product. 

Title Displays the name of the product. 

Scale/Usage Either the scale of the chart is displayed or the usage (e.g. Harbour, 

Approach, etc.), depending on what product is selected. 

Ship Registration Dialogue 

 

 

 

 

 

 

 

 

 

 

 

Figure 14 - Ship Information / Registration dialogue 
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The Ship Registration Dialogue asks for information necessary for the ordering of products. The fields in red must be 

completed as a minimum. The Vessel Name is used for naming the basket and inventory file. 

The section Electronic Chart Systems on Board archives User Permits, ARCS Pin and the Hardware-Id necessary to 

use digital products. These codes avoid the illegal use and distribution of protected products. 

 

Note: The Electronic Chart Systems on Board section is only visible if there are ARCS or ENC Units in 
the Shopping Basket. 

List of Distributors 

This function opens the list of registered Distributors, ordered by distributor name. The list of distributors is also 

accessible from the Shopping Basket. It includes a link to the latest online version of the list which allows users to search 

for a particular distributor either by name or country. 

Tool Windows 

This function opens a menu which allows the user to select or deselect any of the entries below in order to display or 

hide the respective feature. It can also be opened as a context menu by right clicking anywhere except on the chart 

display. 

 

Navigational Globe Removes / displays the Navigational Globe 

Overlay Settings Removes / displays the Overlay Settings 

Usage Settings Removes / displays the Filter (Scale Ranges or Usages) and the 

Restore Default Button (Filter).  

Note: Item Usage Settings is not available (i.e. is not visible) when the Basket tab or Inventory tab are 
selected or other tabs where no filter is used. 

 

Cursor Position Removes / displays the Cursor Position in The Navigation Bar  

Chart Tools Removes / displays The Navigation Bar.  

Menu Item Route 

This menu item facilitates the creation of new routes and the loading and editing of saved or predefined routes. It 

includes the following entries: 

 

 

 

 

 

 

 

Figure 15 - Menu item Route 

Load Route 

This function opens a file selection box which allows the selection of a route file with numbered waypoints. The following 

route files can be loaded: 

 

1. A .7CB file (directENC Admiralty Digital Catalogue format) i.e. a route file created and previously saved in Admiralty Digital 

Catalogue. 

2. A text file whose content must follow a defined format, e.g. waypoint lists generated by certain ECDIS systems. 

3. Additionally the following decimal lat / long format is accepted: 
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 53.88  9.18 

 53.88  9.13 

 53.87  9.09 

 53.86  9.05 

 53.85  9.01 

 53.84  8.93 

 

The coordinates are tab separated and any number of decimal places is acceptable. The Lat & Long coordinates are 

negative when in the West or South respectively. 

Note: A third field for the designation of the waypoint (Wpt1, Wpt2, Wpt3, etc.) will be generated 
automatically in Admiralty Digital Catalogue during display. 

 

Please see chapter Create Route unterhalb for how to manually create a route with numbered waypoints in Admiralty 

Digital Catalogue. 

Save Route as 

This function saves a created route to a .7CB file (directENC). A dialogue is opened to specify the location and name of 

the route file.  

Clear Route 

This function removes the route from the Chart Display. 

Create Route 

After selecting Create Route you can position the waypoints of the new route on the chart display. The route is 

automatically in edit mode (see Edit Route unterhalb). 

 

Whenever the left mouse button is clicked a new waypoint is set. The right mouse button will terminate the route. The 

route is still in edit mode and can be modified if necessary. The edit mode must be deactivated with another right click to 

apply the changes. 

 

The waypoints are numbered consecutively WP_001, WP_002, etc. and will be displayed provided Display Product 

Labels and Place Names is selected (see Menu Item Options unterhalb). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16 - Creating a new route with names 

displayed 
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Note: It is not possible to display more than one route at a time. 

Edit Route 

This function toggles between edit mode and non-edit mode. When the route is in edit mode, it is displayed as a solid, 

thin red line. The waypoints are marked by a circle as in normal display mode but no waypoint name is shown. 

Whenever the mouse cursor is close to a waypoint, it will change its shape to a four directional arrow, indicating that by 

clicking here the waypoint can be moved. If the cursor is close to a leg line, its shape turns into a simple 'crosshair' 

cursor. The cursor indicates that the user can insert a waypoint into this leg. Whenever the first or last waypoint of a 

route is moved, after setting its new position, a new waypoint is automatically inserted under the cursor. Thus the user 

can continuously extend the route at either end. 

 

Pressing the Esc key while a waypoint is moved will cancel the move and the waypoint will remain at its original position. 

 

Pressing the right mouse button has different meanings, depending on the context. If a waypoint is being moved, 

pressing the right mouse button will delete it. If no waypoint is moved, pressing the right mouse button will exit the edit 

mode. 

 

If there were modifications to the route, a window pops up asking whether to apply or discard the changes or offers to 

continue editing. The edit mode can also be stopped by unchecking the Edit Route menu entry. 

Route to Basket 

This function loads all the required products of the selected catalogue for a previously defined route into the Shopping 

Basket. All products which are crossed by the route are listed. This list can be edited in the Shopping Basket. 

Menu Item Options → Options… 

This menu item opens the Options dialogue. In it you can set General Preferences. 

 

Note: Preferences which have been set will remain as the default until they are altered again. 

 

General Preferences 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17 - General Preferences of Options dialogue 
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In the index card General Preferences the following preferences can be set: 

 

Default Work Directory: Can be selected by clicking on the Browse button 

Scale Textfont By: Sets the size of text – the default is 120% (percentage of the 

original size) 

Show Water in Greymode: Displays water areas in grey colour, otherwise it is shown in 

blue 

Display Product Labels and Place 

Names: 

Displays product labels and names of waypoints, cities, 

rivers etc on the chart.  

Display Graticule: Displays a graticule. The distance between the parallels and 

meridians is determined automatically, depending on the 

display scale. 

Display Warning Messages 

(Balloon Tip): 

Displays warning messages e.g. there are no products 

available in the basket or inventory, or all usages are 

invisible. 

Show Products on Mousehover: Opens a window displaying information about the charts at 

the cursor location. 

Add Products Directly to Basket: When checked this will by-pass the product selection 

window, adding all products at the selection point directly into 

the basket.  

Select Products Partially: 
When selecting products with the selection rectangle,  , 

this option determines whether the product has to be fully or 

only partially covered by the rectangle.  

 

 

 

 

 

 

 

 

 

 

Figure 18 - Mouse Hover: Display of products of an area the mouse cursor is set on 

 

Zoom Rectangle opens from … 

 …Center to Corner 

 …Corner to Opposite Corner 

  

Clicking on Restore Defaults at bottom left will set back all changes made to the original default General Preferences 

settings and Route Buffer widths. 
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Colour and Intensity 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 19 – Colour & Intensity 

 

This provides the facility to amend the colour and intensity of the hatching which depicts whether an ENC cell has 

supplementary information. This information will be displayed in the Notes column of the shopping basket. 

Route Buffer Widths 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 20 – Route Buffer Widths dialogue 

 

This dialog enables the user to define buffer widths for route planning. When this is set, all products that intersect the 
defined buffer will be added to the basket. 
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Figure 21 – Route with Buffer Widths defined 

Menu Item Help 

This menu item includes the following entries: 

Help (F1) Opens the User’s Guide as .pdf document.  

About Admiralty Digital Catalogue  

Gives information about the currently used version of Admiralty Digital Catalogue and 
information about the QT version used to develop Admiralty Digital Catalogue. 

 

The Navigation Bar 
At the top of the window below the Menu Bar there is the Navigation Bar. It facilitates navigating within the Chart Display. 

On the left end of the Navigation Bar the Cursor position is displayed. 

 

 

Figure 22 - Cursor position in the Navigation Bar 

 

To the left of the cursor position display there are several buttons in the Navigation Bar. 

 

Figure 23 - The Navigation Bar 

 

The buttons have the following functions: 

 
Scroll Left (Left) Shifts the display window to the left (chart to the right). 

 
Scroll Right (Right) Shifts the display window to the right (chart to the left). 

 
Scroll Up (Up) Shifts the display window upwards (chart downwards). 

 
Scroll Down (Down) Shifts the display window downwards (chart upwards). 

 
Zoom In (PgDown) 

Enlarges the display scale of the chart currently displayed 

(reduces the size of the displayed area). 

 
Zoom Out (PgUp) 

Reduces the display scale of the chart currently displayed 

(enlarges size of the displayed area). 
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Maximum Zoom Out 

(Ctrl+PgUp) 
 

 

View Backward 

(Backspace) 
Goes back to the previous view. Grey when disabled. 

 

View Forward 

(Ctrl+Backspace) 
Goes forward to the next view. Grey when disabled. 

 
Search (Ctrl+F) Opens the Search window. 

 
Clear Highlights (Ctrl+H) 

Turns off highlights (see respective button to highlight 

products in the Shopping Basket and Inventory.  

  

 

Selection of a harbour from a drop-down list or enter part 

of the harbour name to search. 

 

Select Products For 

Basket By Rectangle 

(Ctrl+R) 

Product selection rectangle option. All available products 

from the current catalogue, wholly within a rectangle, will 

be selected and displayed in the Products Found In 

window.  

 
Open Basket (Ctrl+B) Opens the Shopping Basket window.  

 

Open Ship Registration 

(Ctrl+S) 

Opens the Ship Information / Registration Dialogue (see 

chapter Ship Registration Dialogue. 

 
Route to Basket (Ctrl+O) 

Loads all products from the selected catalogue required 

for a previously defined route into the Shopping Basket. 

Search 

The Search window is opened by clicking on the  button in the Navigation Bar. 

 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 24 - The Search window 

In the Search Expression input field you can enter either the number of the product you are looking for, or the name of 

the product or the product area. 

 

You can also define whether the entered character string is contained in the result, or whether it must be an exact 

match. Under Result Must… at the bottom of the window tick: 

 Contain String or 

 Match Exactly 
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It is also possible to define whether the search shall be carried out for 

 Product Number 

 Product Title 

 Product Area 

 Cell Name 

 Unit Size 

 All Attributes 

 

Note: When Product Number is selected Product Title and Product Area are disabled. However, it is 
possible to search for Product Title and Product Area either separately, or in combination. 

 

Search in Product Number 

After selecting the catalogue which contains the desired product, enter the product number and click on Search. The 

result will be displayed in the Products Found In window. 

 

 

Figure 25 - Search for product number 857 in the ARCS (Raster Charts) Catalogue 
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When searching for AVCS Folios, the limits of the individual ENCs will be shown on the Chart Display. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 26 – ENC Limits shown for selected AVCS Folio 

 

To determine the name of the individual ENC units shown on the display, select ENC Units. As the image is zoomed in, 

ENC unit names will be displayed on the Chart Display. Alternatively if Show Products on Mousehover has been 

selected, then details will be displayed when the mouse is placed over the unit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 27 – ENC details shown 
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Search in Product Title 

After selecting the catalogue which contains the desired product, enter the title and click on Search. The result will be 

displayed in the Products Found In window. 

 

It is possible to enter the complete name of the desired product, or a part (string) of the name. No wildcards are required. 

Search in Product Area 

If you want to search for the Product Area you must enter an Area Code, from the respective catalogue, into the Search 

Expression field. This search is primarily used for the ARCS areas, e.g. RC4 etc. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 28 - Entering Product Area (RC4 

from the ARCS Catalogue) 

Search in All Attributes 

This will allow the user to search on all product data including product title, IDs etc. 

 

The result will be displayed in the Products Found In window. 

Found Products 

When no data matches the search criteria in the currently selected catalogue the following message will be displayed. 

 
 
 
 
 

 

Figure 29 - The Warning window 

The results of the various search operations are displayed in the Products Found In window. The Products Found In 

window is opened by either the Search operation or by right clicking into the Chart Display. 

 

Note: When right clicking into the chart display only visible products (filtered by the Overlay Settings 
and the Usage / Scale Filter) will be listed in the Products Found In window. 
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Figure 30 - Products Found In window 

 

For each found product the Product Type, Product number, Title, Usage and Scale are given. It is also possible to sort 

the products according to one of these characteristics by clicking on the title of the respective column. 

 

In addition, there are three more columns in the Products Found In window: 

 

Highlight Products 

It is possible to highlight one or more products in the Chart Display. This is done by clicking on Highlight in the product 

row. For highlighted products Normal Display is shown instead. Clicking on it will turn off the highlighting. 

 

All On highlights all listed products 

All Off turns off the highlighting of all listed products 

Note: It is possible to set all highlighted products back to normal display at once. This is done by 

clicking on the button Clear Highlights  in the Navigation Bar. 

 

Note: Clicking on the title of a product (rather than on Highlight) will zoom to the product and highlight it. 

 

Adding Products to Basket 

By clicking on Add in the Basket column you can add the found product to the Shopping Basket (or Remove it, 

respectively). 

After the product has been put into the Basket the text is highlighted by a red bar (see below).  

 

Adding Products to Inventory 

By clicking on Add in the Inventory column you can add the found product to the Inventory (or Remove it, respectively). 

After the product has been put into the Inventory the text is highlighted by a yellow bar (see below). 
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Figure 31 - Products Found In window displaying product in Shopping Basket and Inventory 

If a product is in both the Basket and Inventory then it is highlighted in red text over a yellow bar. 

 

Add All Adds all listed products to the Basket or Inventory 

Remove All Removes all listed products from the Basket or Inventory 

Legend: At the bottom right corner shows the meaning of the colours used in the list. 

Goto Harbour 

This function incorporates an index of ports and harbours of the world in alphabetical order. As well as scrolling through 

the list it is possible to type in a part of the harbour/port name and the catalogue will show the best match. 

 

 

 
 
 
 
 
 
 
 

Figure 32 - Drop-down list Goto Harbour 

When a port is selected the Navigational Globe and the Chart Display will change to show the selected harbour in the 

centre of the respective display. 

 

Port selection can be aided by typing the first letter of the port name. 

 

The Navigational Globe 
There is a Navigational Globe plus four arrow keys displayed in the top left of the Admiralty Digital Catalogue screen. 

The arrow keys can be used for navigating around the globe. 

  

Use View → Tool Windows to turn the globe on and off, or right click outside of the Chart Display. 
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Figure 33 - Navigational Globe 

 

With the arrow buttons the globe can be rotated left, right, up or down. 

 

Left clicking any position on the globe will display this position as the new centre of both the globe display and the Chart 

Display at the current scale. 

 

When a port is selected (see Goto Harbour oben) this port will become the centre of the globe display. 

 

The current view of the Chart Display is indicated by a red rectangle on the globe. 

 

Overlay Settings 
Selecting / deselecting will display / hide the products which are in the Shopping Basket or Inventory overlaid in the 
various catalogues as red or yellow limits respectively. 
 

 

Figure 34 - Overlay Settings 

 

The lower section offers options for the Shopping Basket and Inventory overlay display in the different catalogue tabs. 

 Current Catalogue Only:  Overlays only the products in the Shopping Basket or Inventory of the currently selected 

catalogue tab. Deselect it to view all products which are in the Shopping Basket or Inventory from all catalogues. 

 Act.(ive) Usages/Scale Ranges Only:  Overlays only the products in the Shopping Basket or Inventory of the currently 

selected usages / scale ranges. Deselect it to view all products which are in the Shopping Basket or Inventory from all 

usages / scale ranges.  

 Hide Selected Products:  Hides/clears all products on the Chart Display from the currently selected catalogue tab which 

are already in the Shopping Basket or Inventory. 

 

Note: The option Hide Selected Products slows down the display. 
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Filter 
 

In the Filter area (View → Tools Window → Usage Settings) of the Admiralty Digital Catalogue user interface you can 

select one or more Scale Ranges, Usages or Levels for display depending on the product selected and displayed in the 

Chart Display. 

 

Note: The Products Found In for each right click on the Chart Display is based on the selected 
(activated) Scale Ranges, Usages or Levels only. 

Scale Ranges (T&P NMs, Paper Charts & ARCS) 

Each paper chart or ARCS chart has a particular scale. They can be viewed on the Chart Display by scale range. By 

ticking (or deselecting) Vis.(ible) single scale ranges can be displayed or hidden. 

 

 
 

 

 
 
 
 
 
 
 
 

Figure 35 - Scale Range Settings (T&P NMs, Paper Charts & ARCS) 

Folios and ENCs (AVCS) 

The Admiralty Vector Chart Service (AVCS) can be ordered and viewed in two ways – Folios and ENCs. The display 

can be adjusted by selecting either Folios or ENCs. 

 

Folios consist of three groups – Transit, Regional and Port. By ticking (or deselecting) Vis.(ible), single Folio types can 

be displayed or hidden. 

 

The folio definitions are summarised below – more detailed descriptions can be found on the UKHO website 

www.ukho.gov.uk : 

 

Transit folios provide sufficient coverage for a vessel to pass safely through a region. 

Regional folios contain predominantly coastal (band 3) cell coverage. 

Port folios contain Approach (band 4), Harbour (band 5) and Berthing (band 6) cell coverage. 

 

ENCs consist of 6 usage bands – Overview, General, Coastal, Approach, Harbour and Berthing. Each ENC is assigned 
to a particular usage band (for navigational purposes). They can be viewed on the Chart Display by usage band. By 
ticking (or deselecting) Vis.(ible), single usages can be displayed or hidden. 

 

http://www.ukho.gov.uk/
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Figure 36 – Folios and ENC Settings (AVCS) 

Levels (ECDIS) 

Each ECDIS Service folio is assigned to a Full, Standard or Transit level which describes the navigational purpose of the 

folio and thus the extent of the ENC and ARCS content of the folio. By ticking (or deselecting) Vis.(ible) single levels can 

be displayed or hidden. 

 

The folio definitions are summarised below – more detailed descriptions can be found on the UKHO website 

www.ukho.gov.uk : 

 

Transit: only contains ENCs and ARCS required for safe transit through the area. 

Standard: contains ENCs and ARCS required for operational use including all key ports and approach charts. 

Full: contains all ENCs and ARCS available for the area. 

 

 

Figure 37 - Level Settings (ECDIS Service) 

Restore Default Button (Filter) 

Clicking on Restore Default will set back all changes made to the filter settings. 

 

 
Figure 38 - Restore Default button 
 
 

The Chart Display 
All products can be viewed in the Chart Display. 

 

The desired geographic area can be selected either by using the Navigational Globe or by the 'grab and pan' facility 

available when the middle mouse button (wheel) is pressed. It is also possible to enter a port name (see chapter Goto 

Harbour oben) or to search for a certain product (see Search oben). 

 

A single click with the middle mouse button will set a new centre. Clicking, holding and dragging the left mouse button 

will open a rectangle defining the new view. 

Select any of the catalogues in the Tab Bar to view the chart types / products or select the Shopping Basket or the 

Inventory to view the contents. 

http://www.ukho.gov.uk/
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Charts and products can be selected on the Chart Display and added to the Shopping Basket by either opening the 

Products Found In dialogue using the right mouse button, and clicking on Add or using the function Select Products for 

Basket by Rectangle (click  from the Navigation Bar) or by using the Route to Basket function. The Products Found 

In dialogue can also be opened by using the Search function (click  from the Navigation Bar, see Search oben). 

 

By default products contained in the Shopping Basket or the Inventory are always shown in the Chart Display, 

regardless of the tab currently selected. However, they can be turned off (made invisible) by using the Overlay Settings.  

 

By default products in the Shopping Basket are displayed with red outlines, while products in the Inventory have yellow 

outlines.  

 

When the tabs Contents of Basket or Contents of Inventory in The Tab Bar are selected the products will be displayed in 

the colours of the respective catalogues containing these products. 

 

By means of the Basket Overlay Settings and Inventory Overlay Settings (see Overlay Settings oben) you can specify 

whether products which are in the Shopping Basket or Inventory, of all catalogues, or only of the selected catalogue 

shall be shown. Additionally, products already in the Shopping Basket or Inventory can be hidden from the display. 

 
In the following figures there are three examples how products can be presented in the Chart Display. 
 

 
 
Figure 39 - Display of products from the ARCS catalogue including products that have been previously loaded into the 
Basket (red outline) and Inventory (yellow outline) 
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Figure 40 - Display of Contents of Basket including products from the ARCS catalogue (olive-coloured). The products 
with the yellow outline are in the Inventory. 
 
 

 
 
Figure 41 - Display of the Contents of Inventory which contains products from the ARCS catalogue (shown by olive 
outline).  
 

Right clicking on the Chart Display opens the Products Found In dialogue box showing all products of the selected 

catalogue that are found at the clicked position. 
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T&P NMs 
T&P NMs contain information that is sufficiently significant to need to be communicated to the mariner but which is either 

too transient (e.g. works in this area for 8 weeks) for a standard NM or needs communicating too quickly to have 

completed the appropriate NM action (e.g. a new port operation that will require a New Edition to depict it properly). 

 

T&P NM information is currently provided with reference to specific paper chart products however the information 

contained is relevant to the user of any chart products in the area covered.  

 

The TPNMs tab displays the limits of all affected charts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 42 - Display of the T&P NMs tab 

T&P NMs that are not associated with a specific chart can be displayed by selecting the misc T&P NMs button. 

To select T&P NMs associated with a specific chart right click on the appropriate chart and a list of associated T&P NMs 

will be displayed. 

 
 
 
 
 
 
 
 
 

 

 

Figure 43 – List of T&P NMs available 

 

To view the contents of the T&P NM select View or View All. 
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Figure 44 – T&P NMs window 

From this window it is possible to either save the T&P NM as an html file or to print the contents of the T&P NM file. 

When the TPNMs tab has been selected, the Search window is replaced to allow T&P NMs to be selected by number, 

text, title, date or chart number. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 45 – T&P NMs Search window 

 

Other Products 
The Other tab includes the Admiralty range of Thematic Charts and Miscellaneous Publications. These products do not 

benefit by being displayed graphically on the Chart Display and so are presented as categorised lists within a new plain 

window that replaces the Chart Display. They are selected from a drop-down list at the top of the window. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 46 - The Other Products Window 

(Thematic Charts and Miscellaneous 

Publications) 
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The Tab Bar 
 

The Tab Bar at the bottom of the Admiralty Digital Catalogue user interface is used to control the contents of the Chart 

Display. It consists of a series of coloured tabs. 

 

 

Figure 47 - The Tab Bar 

The current set of tabs (left to right): 

Basket  Contents of Basket 

Inventory Contents of Inventory 

TPNMs T&P NM information 

Paper Charts British Admiralty Paper Chart Service (SNCs) 

ARCS Admiralty Raster Charts (ARCS) 

AVCS Admiralty Vector Chart Service (ENCs and AVCs) 

ECDIS  ECDIS Service  

SDs Admiralty Sailing Directions (Pilots) 

ATT Admiralty Tide Tables  

TotalTide Admiralty TotalTide 

ALL Admiralty List of Lights 

ADLL Admiralty Digital List of Lights 

ALRS Admiralty List of Radio Signals (ALRS) 

ADRS2 Admiralty Digital Radio Signals Vol. 2 

ADRS6 Admiralty Digital Radio Signals Vol. 6 

Other Other Products (Thematic Charts and Miscellaneous Publications) 

 
 

The Context Menus 
A context menu is available in the Tab Bar. It is opened by right clicking the respective tab and allows the deletion of a 

single catalogue. To reinstall that catalogue it must be downloaded again or installed from disk, similar to updating a 

catalogue (see Catalogue oben). 

 

 
Figure 48 - Context Menu on Tab Bar: Delete Catalogue 
 

Whenever you right click on the Admiralty Digital Catalogue user interface (apart from the Chart Display and the 

attached Tab Bar) a second Context Menu opens. 

 
 
 
 
 
 
 
 

Figure 49 - Context Menu on User Interface 
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Selecting or deselecting any of these entries will display or hide the respective feature. See Tool Windows oben for 

detailed explanations of the single entries. 

 

Note: The item Usage Settings is not available when Basket, Inventory and single usage products are 
selected / displayed, e.g. SDs. 
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6. Glossary 

 
Basket / Shopping Basket Dialogue to manage the products to be ordered (see Basket ) 

Basket File 

Contains the products which have been collected in the Shopping 
Basket and saved with File → Save Basket.  

The file is named order_vesselname_YYYYMMDD.txt.  

The contents of the basket file can be shown in Admiralty Digital 
Catalogue with File → Load Basket… and, if loaded, clicking on the 
Basket tab (see chapters  

Save Basket…, Load Basket… and The Tab Bar).  

The basket file is a tab separated file with the following columns: 

1. Product Type 

2. Product Number 

Catalogue 
Collection of products of certain type (e.g. ENCs, ARCS, BA paper 
charts, List of Lights), shown on the Chart Display (see The Tab Bar) 

Inventory Dialogue 
Dialogue to manage the products which are already on board (see 
Basket ) 

Inventory File 

Contains the products of the Inventory which have been saved with 
File → Save Inventory….  

The file is named inventory_vesselname_YYYYMMDD.txt.  

The contents of the inventory file can be shown in Admiralty Digital 
Catalogue with File → Load Inventory… and, if loaded, clicking on the 
inventory tab (see Save Inventory…, Load Inventory… and The Tab 
Bar) 

The inventory file is a tab separated file with the following columns:  

1. Product Type 

2. Product Number 
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7. Trouble Shooting 

Frequently Asked Questions 

 

How do I order chart units? 

 

There are two ways to collect the appropriate charts and products: 

1. Based on a defined route: 

 Create or import your route 

 Select the appropriate catalogue(s) and click Route to Basket from the Navigation Bar. All products, from 
the currently selected catalogue tab, crossed by the route are transferred to the Shopping Basket. 

 Any product which is not required can be removed in the Basket dialogue. 

 

2. Manual selection of products 

 Select the appropriate catalogue(s) 

 Open the Products Found In dialogue by right clicking on the required products or by using the Search 
function. Use the Add/Remove functions in the Products Found In dialogue. 

 

The contents of the Shopping Basket are shown in the Basket catalogue (select Basket from the Tab Bar). Once all 

required products from the different catalogues are in the Shopping Basket you can save a basket file. The file is named: 

order__YYYYMMDD.txt or  order_vesselname_YYYYMMDD.txt if the Ship Registration Dialogue has been 

completed. 

 

The basket file can then be sent/emailed to a distributor. 

 

How do I maintain the inventory? 

Once you have received the products from your distributor the list of charts and products must be transferred to the 

Inventory. Since the basket file contains exactly this information it is recommended that you: 

 reload the basket file into the Shopping Basket 

 open the Basket dialogue 

 transfer the products to the Inventory using the transfer arrows between the Basket and Inventory 
section. 

 save the products in the Inventory as an inventory file.  

 If additional products are required the inventory file can be re-loaded in order to compare the stock of 
products with a new selection. The missing products can then be ordered. 

 

The unit numbers shown in the chart display are illegible? 

 

This is a problem with the “cleartype” engine of windows. Please set your windows display options from 'cleartype' to 

'standard'. This can be found in Control Panel → Display → Appearance → Effects → Checkbox "use the following 

method to smooth edges of screen fonts:" → select: standard. 
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Planning for the future? Serving our users 24/7, worldwide, 365 days a year 

Plan with ADMIRALTY Nautical Products & Services, 

brought to you by the United Kingdom Hydrographic 

Office. 

For more world-class, world-leading products and 

services visit our website www.admiralty.co.uk 

 

For more information and advice, contact our global network 

of chart agents. 

Alternatively our in-house customer service team is available 

day in, day out – whatever the query and wherever your 

journey takes you. 

file://Ryserver1/artwork/U/UKHO/Web%20Userguides/www.admiralty.co.uk
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